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Access Tour

I n t h i s c h a p t e r y o u w i l l l e a r n :
• Access’s capabilities and new features

• How to start, navigate, and work with Access files

• How to use Access help

• How Access is used in accounting

Case: What SUP, Inc.

Nathan and Meagan have expressed an interest in other software that might be
able to help them in their business. Kyle asks them what kinds of records they
keep for customer orders and inventory control.

‘‘We keep records by hand now, and it is very tedious and problematic,’’
Meagan responds. ‘‘I have a file for customers, suppliers, products, et cetera,
but often they get misplaced and are frequently out of date. It’s difficult to keep
track of it all!’’

‘‘Well, perhaps a database management system might help you out,’’ sug-
gests Kyle.

‘‘What’s a database management system?’’ asks Nathan.
Kyle explains that, as their business grows, the information available to them

will increase as well. A database management system (DBMS) can help.
‘‘Essentially, a DBMS is a tool for storing, retrieving, and interpreting informa-
tion in an effective and useful way. These days, Microsoft’s Access program, a
relational database management system, has proven to be a very successful tool
in combating information overload.’’

‘‘Hold on,’’ warns Nathan. ‘‘What is a relational database?’’
‘‘Ok, let’s go slowly,’’ responds Kyle. ‘‘Let me walk you and our student

assistant through the basics and I’ll define relational database then.’’
‘‘Great,’’ you respond. ‘‘I know businesses use databases every day, and this

way I can get a better insight on how they are created and used.’’

Understanding Access’s Capabilities
and New Features

Access is a DBMS that organizes a collection of related information used for a
specific purpose. For example, information about What SUP’s customers, its
suppliers, and its products could be three different databases in and of
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themselves. A relational database is one in which information is divided into
separate stacks of logically related information, each of which is stored in a sep-
arate table in the file. Thus, tables are a critical part of a DBMS, and the rela-
tions among the tables are key to its success.

Tables can be related in three different ways: one-to-many, one-to-one, and
many-to-many. For instance, the supervisor of an accounting department may
have many employees who work under her; however, all the employees who
work for her have only one supervisor. This would be a one-to-many relation-
ship: one supervisor to many employees. Another example is the chief financial
officer (CFO), who reports to the chief executive officer (CEO). This is a one-
to-one relationship because there is only one CEO and one CFO. Still another
example is the construction worker who works on many different jobs and each
job requires many different workers. This is an example of a many-to-many
relationship. The most common of these, and the ones you’ll experience here,
are the one-to-many relationships.

The DBMS includes more than just tables, of course. Queries, forms, and reports
based on the data stored in tables are what make up the management component of
DBMS. Before you get too far, Kyle suggests you learn how to start Access.

What’s new in Access 2013? In a word, apps. An Access web app is a new
type of database that you build in Access, then use and share with others as a
SharePoint app in a web browser. To build an app, you just select the type of
data you want to track (contacts, tasks, projects, and so on). Access creates the
database structure, complete with views that let you add and edit data. Navigation
and basic commands are built-in, so you can start using your app right away.

Microsoft has included Intellisense in the Expression and Query Builder portions
of Access. Intellisense helps complete the field names and other items you might
use in these areas. This reduces the margin of error when working with queries
and expressions, as well as the time spent looking up the spelling of field names in
large databases. Access 2013 also allows conditional formatting within reports,
showing the information that meets a certain condition or set of conditions. To use
or change the conditional formatting rules in a report, open the report, choose the
Format tab on the Ribbon, and then select the Conditional Formatting option.

Starting, Navigating, and Working
with Access Files

Kyle asks you if you are familiar with starting programs in Windows XP.
Nathan and Meagan don’t know much about computers, so you offer to demon-
strate. First you explain that starting Access is the same regardless of whether
the computer’s operating system is Windows 7, 8, XP, or Vista, and then you
offer to demonstrate the process for starting Access in Windows XP.

To start Access:

1 Click the Start button.

2 Click All Programs, then click the Microsoft Office folder, and then click
Microsoft Office Access 2013. Your window may look like Figure 8.1.
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Nathan’s laptop has Access installed as well, so he has been duplicating
Kyle’s actions on his own computer, whose screen looks somewhat different
than Kyle’s—in particular, Kyle’s Quick Access Toolbar and Ribbon seem dif-
ferent. Kyle explains that screen size can change the appearance of the Ribbon
and that, just like Access itself, both its Ribbon and Quick Access Toolbar can
be customized.

To illustrate, Kyle starts Access and creates a new blank database file named
Database1. He has captured his Access window (see Figure 8.2) and provided
callouts and an explanation of the Access window characteristics. He reminds
you that the user interface described here is similar to Excel’s interface, so
much of this will sound familiar.

File Menu – The File menu is where you manage your files and the data about
them-creating, saving, inspecting for hidden metadata or personal information,
and setting options. In short, it is everything that you do to a file that you don’t
do in the file.

Quick Access Toolbar – At the top of the Access window is the Quick Access
Toolbar, which is designed to provied an easy way to execute the commands
used most often. The default setting in Access provides access to the Save,
Undo, and Redo commands.

3 Click Microsoft Office Access 2013 to start the application.

T r o u b l e ? Your start menu may be completely different from that
shown in Figure 8.1. See your instructor or lab personnel for instruc-
tions on starting Access.

Figure 8.1
Starting Access
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Ribbon – There are three basic components of the Ribbon.

1 Tabs: There are several of them across the top depending on whether you
have added any add-ins to Access; each represents core tasks you do in
Access.

2 Groups: Each tab has groups that show related items together.

3 Commands: A command is a button, a box to enter information, or a
menu.

The principal commands in Access are gathered on the second tab, the Home
tab. The commands on this tab are those that Microsoft has identified as the
most commonly used when people do basic tasks with databases. For example,
the Paste, Cut, and Copy commands are arranged first on the Home tab, in the
Clipboard group. Font formatting commands are in the Font group. Groups pull
together all the commands you’re likely to need for a particular type of task,
and throughout the task they remain on display and readily available, instead of
being hidden within menus. These vital commands are visible above your work
space.

The commands on the Ribbon are the ones you use the most. Instead of
showing every command all the time, Access 2013 shows some commands in
response to an action you take. When you see an arrow (called the Dialog Box

Vertical Scroll Bar

RibbonHelp ButtonGroupsCommandsTabs
Shutter Bar

Open/Close Button
Select Category

HereQuick Access
Toolbar

File Tab

Navigation
Pane

Horizontal Scroll Bar

Figure 8.2
The Access Window
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Launcher) in the lower right corner of a group, there are more options available
for the group. Click the arrow, and you’ll see a dialog box or a task pane.

Navigation Pane – At the left of the Access window is the Navigation Pane.
New in Microsoft Office Access 2013. It is a central location from which you
can easily view and access all database objects such as tables, queries, forms,
and reports. The Navigation Pane replaces the Database window, which was
used in earlier versions of Access.

Other Access Window Items – Like all Windows screens, scroll bars control
your view of the worksheet (horizontal and vertical).

To demonstrate some of Access’s features, Kyle suggests
you follow along while he opens an Access file:

1 Open Access, if you closed it previously.

2 Click the drop-down arrow on the right of the Quick Access Toolbar
and then click More Commands.

3 Scroll down the list of popular commands and then double-click the text
Open and then click OK. Note that your Quick Access Toolbar now
shows a folder icon, which gives you a quick way to open new files.

4 Click the new Open icon in the Quick Access Toolbar to open a new
file. (Note: If you are using Access in a computer lab environment,
your changes to the Quick Access Toolbar may not reappear the next
time you start Access.)

5 Navigate the Open window to the location of this text’s student files.
(The location would be the CD provided with the text or from your
computer lab’s server.)

6 Double-click the file ch8-01, which should be located in a Ch 08 folder.

7 Click the Shutter Bar Open/Close button a few times to see how it
opens and closes the Navigation pane.

8 With the Shutter Bar Open, select All Access Objects as the category
and Object Type as the category view.

9 Click the Table header a few times to see how you hide or show its con-
tents. (Note: This works for all group headers like tables, queries, forms,
and reports. The navigation pane does not display empty groups; if this
database did not have any reports, the group header would not display.)

10 Double-click the Table Products table. The table shown in Figure 8.3
should appear.

11 Click the File tab and then click the text Save As. Then click the Save
Database As button and then select Access Database (*.accdb) as the
Database File Type. (This is done to keep your original student file available,
in case you need it again, and also to provide a unique name for your file.)

T r o u b l e ? The action above was designed to save the entire
database with a different file name. It is not the same as clicking the
Save Object command, which only saves the current object (table,
query, form, report etc.).
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12 Click Save As and then click Yes when asked if you want Access to
close all open objects.

13 Add your name to the file name using the underscore key, as shown
in Figure 8.4. In this example the file will be saved as ch8-01_
student_name into a folder called My Access Files. You should
replace ‘‘student_name’’ with your name.

14 Click Save.

Figure 8.4
Saving a Database

Figure 8.3
Sample Table
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Now that you’ve had a brief view of how to start, navigate, and work with
Access files, it’s time to become familiar with Access’s help features.

Getting Access Help

Access’s help features are quite extensive. Whenever you are working with
Access and are not certain how to create tables, queries, forms or reports you
should press the [F1] function key or click the blue and white question mark on
the Tab bar. To illustrate, Kyle decides to show you Access’s help feature while
trying to create a new table.

To view Access’s help to create a new table:

1 Press the [F1] function key or click the blue and white question mark
to open Access’s help window, as shown in Figure 8.5.

T r o u b l e ? You do not have to be connected to the Internet to get
Access help. However, the online help is much more extensive. This
example assumes you are connected to the Internet. If you are not con-
nected, click the text Show me offline help from my computer to view
Access help, keeping in mind your window may not match the Figures
shown in the text.

2 Click Introduction to tables from the Access Help window.

Figure 8.5
Access’s Help Window
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Now that you’re familiar with Access’s help feature, Kyle thinks it would be
a good idea to explore how Access is used in the accounting field.

Examples of How Access Is Used in
Accounting

There are an unlimited number of ways Access can be used in accounting. This
text will focus on how Access can be used to track inventory, but of course that
is just one example.

Accounting programs like QuickBooks and Peachtree are nothing more than
sophisticated databases. Each organizes information by accounts, such as assets
(cash, accounts receivable, inventory, etc.), liabilities (e.g., accounts payable),
and equities (common stock and retained earnings). Revenue and expense trans-
actions are also organized by accounts. A user who wants to create an income
statement is simply creating a query that says, in essence, ‘‘give me the sum of
all revenues and all expenses that occurred for a specific period.’’ Thus the
transactions are filtered by date and by account types.

3 Click the text Overview to expand the help text. The help window
shown in Figure 8.6 should appear.

4 Note that the text now displayed gives you more information on Access
tables. Close the Help window.

Figure 8.6
Access Help for Tables
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All the major asset and liability accounts are supported by a database. For
example, the accounts receivable balance sheet account is supported by a
detailed subsidiary ledger that can explain how much each customer owes at
any point in time, and a query can be generated that filters the information by
date and by customer. Fixed assets accounts (e.g., furniture and fixtures, equip-
ment, buildings) are supported by a detailed subsidiary ledger that can explain
the cost of each asset, its economic useful life, its accumulated depreciation,
and so forth. The accounts payable balance sheet account is supported by a
detailed subsidiary ledger that can explain how much the company owes each
vendor at any point in time; a query can be generated that filters the information
by date and by vendor. Figure 8.7 shows a report that summarizes a firm’s sales
for the year. This report was created from an Access database designed to cap-
ture business events for a firm. Figure 8.8 illustrates a query of inventory on
order the same Access database.

Payroll is supported by a database as well. Information is collected from
employees that includes Social Security number, address, pay rate, exemptions,
and deductions. Time-keeping databases collection information about how many
hours an employee worked on a particular job, day, or area. All of this informa-
tion is stored in employee tables and payroll time tables and is then used to
compute payroll expenses, withholding, paychecks, and cost distributions.
Figure 8.9 shows a form used to collect time data.

The list of database applications for accounting is unlimited, and the illustra-
tions given here are just the tip of the iceberg. However, the goal of this text is
to introduce you to the fundamentals of database design and use, so we will
focus on how to create tables, queries, forms, and reports that are related to in-
ventory control only.

Figure 8.7
Sales Report
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Figure 8.9
Sample Form

Figure 8.8
Sample Query
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End Note

The three of you are impressed by your first exposure to Access and pleased
with your accomplishments so far. You’ve learned some of Access’s capabilities
and new features; how to start, navigate, and work with Access files; how to
use Access help; and how Access is used in accounting.

In the next chapter you will learn how to create tables, queries, forms, and
reports as well as how to print in Access.
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Chapter 8 Questions

1 What is a DBMS?

2 What is a relational database?

3 How are tables related?

4 Identify some new features in the 2013 version of Access.

5 Why would you use the File menu in Access?

6 What and where is the Quick Access Toolbar?

7 Describe the Ribbon.

8 What and where is the navigation pane?

9 What is the quickest way to access help while in Access?

10 Describe ways in which Access is used in Accounting.
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